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Preface

About This Tutorial

The ISE 9.1i Quick Start Tutorial is a hands-on learning tool for new users of the ISE
software and for users who wish to refresh their knowledge of the software. The tutorial
demonstrates basic set-up and design methods available in the PC version of the ISE
software. By the end of the tutorial, you will have a greater understanding of how to
implement your own design flow using the ISE 9.1i software.

Additional Resources

To find additional documentation, see the Xilinx website at:

http:/ /www.xilinx.com/literature.

To search the Answer Database of silicon, software, and IP questions and answers, or to
create a technical support WebCase, see the Xilinx website at:

http:/ /www.xilinx.com/support.
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ISE 9.1i Quick Start Tutorial

The ISE 9.1i Quick Start Tutorial provides Xilinx PLD designers with a quick overview of
the basic design process using ISE 9.1i. After you have completed the tutorial, you will
have an understanding of how to create, verify, and implement a design.

Note: This tutorial is designed for ISE 9.1i on Windows.

This tutorial contains the following sections:

“Getting Started”

“Create a New Project”

“Create an HDL Source”

“Design Simulation”

“Create Timing Constraints”

“Implement Design and Verify Constraints”
“Reimplement Design and Verify Pin Locations”

“Download Design to the Spartan™-3 Demo Board”

For an in-depth explanation of the ISE design tools, see the ISE In-Depth Tutorial on the
Xilinx® web site at: http:/ /www.xilinx.com/support/techsup /tutorials/

Getting Started

Software Requirements

To use this tutorial, you must install the following software:

ISE 9.1i

For more information about installing Xilinx® software, see the ISE Release Notes and

Installation Guide at: http:/ /www.xilinx.com /support/software_manuals.htm.

Hardware Requirements

To use this tutorial, you must have the following hardware:

Spartan-3 Startup Kit, containing the Spartan-3 Startup Kit Demo Board

ISE Quick Start Tutorial
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Starting the ISE Software

To start ISE, double-click the desktop icon,

=

2|
ailimx ISE 9

or start ISE from the Start menu by selecting;:
Start —>All Programs —Xilinx ISE 9.1i —Project Navigator

Note: Your start-up path is set during the installation process and may differ from the one above.

Accessing Help

At any time during the tutorial, you can access online help for additional information
about the ISE software and related tools.

To open Help, do either of the following;:

e Press F1 to view Help for the specific tool or function that you have selected or
highlighted.

e Launch the ISE Help Contents from the Help menu. It contains information about
creating and maintaining your complete design flow in ISE.

EE Xilinx - ISE - C:MutorialMutorial. ise

File Edit View Project Source Frocess ‘Window
tDPHS D FFFD 891
A BB oo i Software Manuals

ilin: on the Web
Tutarials

Tip of the Day

Software Updates. ..

About...

Figure 1: ISE Help Topics
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Create a New Project

Create a new ISE project which will target the FPGA device on the Spartan-3 Startup Kit
demo board.

To create a new project:

1. Select File >New Project... The New Project Wizard appears.

2. Type tutorial in the Project Name field.

3. Enter or browse to a location (directory path) for the new project. A tutorial
subdirectory is created automatically.

Verify that HDL is selected from the Top-Level Source Type list.

Click Next to move to the device properties page.

Fill in the properties in the table as shown below:

¢

L

*

*

¢

Product Category: All

Family: Spartan3

Device: XC3S200

Package: FT256

Speed Grade: -4

Top-Level Source Type: HDL

Synthesis Tool: XST (VHDL/Verilog)
Simulator: ISE Simulator (VHDL/Verilog)
Preferred Language: Verilog (or VHDL)

Verify that Enable Enhanced Design Summary is selected.

Leave the default values in the remaining fields.

When the table is complete, your project properties will look like the following:

EE New Project Wizard - Device Properties

=&

Selzct the Device and Design Flaw far the Praject

Property Mame Walue |
Product Categaory All w
Family Spartan3 w
Device #C35200 A4
Package FT25E w
Speed -4 v
Top-Level Source Tupe HOL
Synthesiz Tool HST WHDLAYerilog) -
Sirnulatar ISE Simulatar YHDLA erilog) -
Preferred Language Verilog -
Enable Enhanced Design Summary
Enable Mezsage Filtering Fl
Dizplay Incremental Meszages [l

[ [t ] [ o

Figure 2: Project Device Properties
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7. Click Next to proceed to the Create New Source window in the New Project Wizard. At
the end of the next section, your new project will be complete.

Create an HDL Source

In this section, you will create the top-level HDL file for your design. Determine the
language that you wish to use for the tutorial. Then, continue either to the “Creating a
VHDL Source” section below, or skip to the “Creating a Verilog Source” section.

Creating a VHDL Source

Create a VHDL source file for the project as follows:

1. Click the New Source button in the New Project Wizard.
2. Select VHDL Module as the source type.
3. Typein the file name counter.
4. Verify that the Add to project checkbox is selected.
5. Click Next.
6. Declare the ports for the counter design by filling in the port information as shown
below:
E= New Source Wizard - Define Module |Z||E|E|
Entity Mame |counter |
Architecture Mare |Behavinla| |
Fart Marme Direction Buz  MSBE LSB S
CLOCK in ~O
DIRECTION in ~O
COUNT_OUT out v 3 0
in v ]
in v ]
in v ]
in v ]
in v ] L
in v ]
in v ] 3
[ < Back l I Mext » ] [ Cancel l

Figure 3: Define Module

7. Click Next, then Finish in the New Source Wizard - Summary dialog box to complete
the new source file template.

8. (Click Next, then Next, then Finish.

The source file containing the entity/architecture pair displays in the Workspace, and the
counter displays in the Source tab, as shown below:
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S Xilinx - ISE - C:\tutorialMutorial.ise - [counter.vhd*]

File Edit Wiew Project Source Process Window Help
PLHBEM B AIBE DL M YD HS L:ixRERX ®o[A:Q
R e e = | Z2 =2 4% 0N
1 ”~
Sources for: | Syrthesis/mplementation | Mumber of:| LUTs | Z  -- Company:
Hierarchy Resources  Preserve 2 —— Engineer:
E]tutoril 5 —- Create Date: 13:50:27 04/21/2006
= £ xc3s200-4f256 6§ —— Design MNeme:
[l counter - Behavioral [counter.vhd) 7 - Module Neme: counter - Behavioral
=1 —— Project Name:
=) — Target Deviges:
10 —— Tool wersions:
11 —— Description:
iz -
13 — DEependencies:
14 =
15 —— Revision:
16 —— BRevisign 0.01 — File Greated
Al —— Additional Corments:
15 =
19
] B3 Sowces | gy Snapshots || [y Libraries 20 library IEEE:
= 21 use IEEE.STD_LOGIC_1164.ALL:
|G 22  use IEEE.STD_LOGIC_ARITH.ALL:
Processes: 23 use IEEE.STD_LOGIC_ UNIIGNED.ALL:
[ AddExisting Source B
s ———— Uncomment the following library declaration if instantiating
M Create Mew Source K | ey i =
i B 26 ———— any Xilinx primitives in this code.
() ‘y‘ Design Utilities s e library UNISIM:
28 ——use UTNISIM.VComponent=s.all;
29
30 entity counter i=
31 Port ( CLOCK : in STD_LOGIC;
SZ DIRECTION : in &TD_LOGIC:
33 COUNT_OUT : out STD_LOGIC VECTOR (3 downto 0));
34 end counter:
35
36 architecture Behavioral of counter is
a7
38 begin
39 A
40
41 end Behavioral:
4z »
ag 85 | >
Processes
| | counter vhd® |
[Ln39 Cal 1 [CARPS [WUM [SCRL [VHDL

Figure 4: New Project in ISE

Using Language Templates (VHDL)

The next step in creating the new source is to add the behavioral description for the
counter. To do this you will use a simple counter code example from the ISE Language
Templates and customize it for the counter design.

1. Place the cursor just below the begin statement within the counter architecture.

2. Open the Language Templates by selecting Edit -Language Templates...
Note: You can tile the Language Templates and the counter file by selecting Window —Tile
Vertically to make them both visible.

3. Using the “+” symbol, browse to the following code example:
VHDL —Synthesis Constructs —Coding Examples —Counters —Binary —
Up/Down Counters —Simple Counter

4. With Simple Counter selected, select Edit sUse in File, or select the Use Template in

File toolbar button. This step copies the template into the counter source file.

®

ISE Quick Start Tutorial
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5.

Close the Language Templates.

Final Editing of the VHDL Source

1.

4.

Add the following signal declaration to handle the feedback of the counter output
below the architecture declaration and above the first begin statement:

signal count_int : std_logic_vector (3 downto 0) := "0000";

Customize the source file for the counter design by replacing the port and signal name
placeholders with the actual ones as follows:

¢ replace all occurrences of <clock> with CLOCK

¢ replace all occurrences of <count_direction> with DIRECTION
¢ replace all occurrences of <count> with count_int

Add the following line below the end process; statement:

COUNT_OUT <= count_int;

Save the file by selecting File —Save.

When you are finished, the counter source file will look like the following:

library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;
use IEEE.STD_LOGIC_UNSIGNED.ALL;

-—- Uncomment the following library declaration if instantiating
-- any Xilinx primitive in this code.

--library UNISIM;

--use UNISIM.VComponents.all;

entity counter is
Port ( CLOCK : in STD_LOGIC;
DIRECTION : in STD _LOGIC;
COUNT_OUT : out STD LOGIC_VECTOR (3 downto 0));
end counter;

architecture Behavioral of counter is

signal count_int : std_logic_vector (3 downto 0) := "0000";
begin

process (CLOCK)

begin

if CLOCK='1l' and CLOCK'event then
if DIRECTION='1l' then
count_int <= count_int + 1;
else
count_int <= count_int - 1;
end if;
end if;
end process;
COUNT_OUT <= count_int;
end Behavioral;

12
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You have now created the VHDL source for the tutorial project. Skip past the Verilog
sections below, and proceed to the “Checking the Syntax of the New Counter
Module”section.

Creating a Verilog Source

Create the top-level Verilog source file for the project as follows:

SANINLEE

Type in the file name counter.
Verify that the Add to Project checkbox is selected.
Click Next.

Declare the ports for the counter design by filling in the port information as shown
below:

E Mew Source Wizard - Define Module

Click New Source in the New Project dialog box.

Select Verilog Module as the source type in the New Source dialog box.

CE&

Module Name |counter

Fort Name Direction Buz  MSE LSE
CLOCK. input ]
DIRECTION inpLt v ]
COUNT_OuUT output v 1]
inpLt v ]
inpLt ~|
inpLt v ]
inpLt v ]
inpLt ~|
inpLt v ]
inpLt v ]
inpLt ~|
- —
[ < Back l I Mest > ] [ Cancel

Figure 5: Define Module

7. Click Next, then Finish in the New Source Information dialog box to complete the new
source file template.

8. (Click Next, then Next, then Finish.
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The source file containing the counter module displays in the Workspace, and the counter
displays in the Sources tab, as shown below:

EE Xilinx - ISE - C:\Mutorial\tutorial.ise - [counter.v]
File Edit View Project Source Process Window Help =1

PLPHHEA B ABE DDA M E DR HS L ¥REX B 09
| B IES S22 ARARON

E 1 ‘timescale 1lns [/ 1ps
|Sourcesfor:iSynthesisflmplementationviNumberof:iLUTs -~ 2 P RPN PR
Higranchy Resources | Preserve o Company:
; . 4 // Engineer:
; f‘ﬂtutunal = |
B 3 200411256 6 // Create Date: 16:39:56 04/25/20086
& ﬁ“ﬁcounter-Behavioral [counter.vhd] 7 /) Design Name:
' counter [counter.v] g // HModule Name: counter

9 // Project Name:
10 /) Target Devices:
11 // Tool wersions:
12 // Description:

abiziv | PR
14 // Dependencies:
15 //

16 // Revision:
17 // Revision 0.01 - File Created
1§ // hdditional Comments:

iEf[?.Sources | 5 Snapshats IELibraries [ NS | PR e T R
=————— 21 module counter (CLOCK, DIRECTION, COUNT_OUT):
22 input CLOCHK;

Processes: 23 input DIRECTION;
[ Add Esisting Source 24 output [3:0] COUNT QUT:
25

M Create New Source

B3 Design Utiities 27 endmodule
“PFQ  Check Syntax 25

| >

<
|Ef| Processes | ot |

Ln 16 Col 4 | CaPS (UM [ SCRL Yerilog

Figure 6: New Project in ISE

Using Language Templates (Verilog)

The next step in creating the new source is to add the behavioral description for counter.
Use a simple counter code example from the ISE Language Templates and customize it for
the counter design.

1. Place the cursor on the line below the output [3:0] COUNT_OUT; statement.
2. Open the Language Templates by selecting Edit -Language Templates...

Note: You can tile the Language Templates and the counter file by selecting Window —Tile
Vertically to make them both visible.

3. Using the “+” symbol, browse to the following code example:
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Verilog —Synthesis Constructs —Coding Examples —Counters —Binary —
Up/Down Counters —Simple Counter

4. With Simple Counter selected, select Edit —Use in File, or select the Use Template in
File toolbar button. This step copies the template into the counter source file.

®

5. Close the Language Templates.

Final Editing of the Verilog Source

1. To declare and initialize the register that stores the counter value, modify the
declaration statement in the first line of the template as follows:
replace: reg [<upper>:0] <reg_name>;
with: reg [3:0] count_int = 0;

2. Customize the template for the counter design by replacing the port and signal name
placeholders with the actual ones as follows:
¢ replace all occurrences of <clock> with CLOCK
¢ replace all occurrences of <up_down> with DIRECTION
¢ replace all occurrences of <reg_name> with count_int

3. Add the following line just above the endmodule statement to assign the register value
to the output port:

assign COUNT_OUT = count_int;
4. Save the file by selecting File —Save.
When you are finished, the code for the counter will look like the following:

module counter (CLOCK, DIRECTION, COUNT_OUT) ;
input CLOCK;

input DIRECTION;

output [3:0] COUNT_OUT;

reg [3:0] count_int = 0;
always @ (posedge CLOCK)
if (DIRECTION)
count_int <= count_int + 1;
else
count_int <= count_int - 1;

assign COUNT_OUT = count_int;
endmodule

You have now created the Verilog source for the tutorial project.

Checking the Syntax of the New Counter Module

When the source files are complete, check the syntax of the design to find errors and typos.

1. Verify that Synthesis/Implementation is selected from the drop-down list in the
Sources window.

ISE Quick Start Tutorial www.xilinx.com 15
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Select the counter design source in the Sources window to display the related
processes in the Processes window.

Click the “+” next to the Synthesize-XST process to expand the process group.
Double-click the Check Syntax process.

Note: You must correct any errors found in your source files. You can check for errors in the
Console tab of the Transcript window. If you continue without valid syntax, you will not be able to
simulate or synthesize your design.

Close the HDL file.

Design Simulation

Verifying Functionality using Behavioral Simulation

Create a test bench waveform containing input stimulus you can use to verify the
functionality of the counter module. The test bench waveform is a graphical view of a test
bench.

Create the test bench waveform as follows:

1.
2.
3.

Select the counter HDL file in the Sources window.
Create a new test bench source by selecting Project —New Source.

In the New Source Wizard, select Test Bench WaveForm as the source type, and type
counter_tbw in the File Name field.

Click Next.

The Associated Source page shows that you are associating the test bench waveform
with the source file counter. Click Next.

The Summary page shows that the source will be added to the project, and it displays
the source directory, type and name. Click Finish.

You need to set the clock frequency, setup time and output delay times in the Initialize
Timing dialog box before the test bench waveform editing window opens.

The requirements for this design are the following;:

¢ The counter must operate correctly with an input clock frequency = 25 MHz.
¢ The DIRECTION input will be valid 10 ns before the rising edge of CLOCK.

¢ The output (COUNT_OUT) must be valid 10 ns after the rising edge of CLOCK.
The design requirements correspond with the values below.

Fill in the fields in the Initialize Timing dialog box with the following information:
¢ Clock High Time: 20 ns.

Clock Low Time: 20 ns.

Input Setup Time: 10 ns.

Output Valid Delay: 10 ns.

¢ Offset: 0 ns.

¢ Global Signals: GSR (FPGA)

Note: When GSR(FPGA) is enabled, 100 ns. is added to the Offset value automatically.

¢ Initial Length of Test Bench: 1500 ns.

* & o
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Leave the default values in the remaining fields.

ES Initial Timing and Clock Wizard - Initialize Timing

Waximum
output delay

high for

_ Clock —— Clock -

[y for

Clock. Timing Information

Inputs are azgigned at "lnput Setup Time"' and
outputs are checked at "Output Valid Delay",

(%) Rizing Edge () Falling Edge
() Dual Edge [DDR of DET)

Clock. High Time ns
Clock Low Time rs
Input Setup Time nz
DOutput v alid Delay nz
Offset rs

Global Signals
PRLD [CPLD) GSR [FPGA]
High for Iritial: 100 | ris

Clock, Information

(&) Single Clack [CLoCK v

) Multiple Clacks

() Combinatorial [or internal clock]

Combinatorial Timing Information

Inputs are azsigned, outputs are decoded then
checked. & delay between inputs and outputs avoids
azzignment/checking conflicts.

Check Outputs ng After Inputs are Assigned
Agzign Inputs ng After Jutpute are Checked

Initial Length of Test Bench: | 1500 ng
Time Scale: | nz A4

[] Add Asynchronous Signal Suppart

< Back [ Finish I ’ Cancel

Figure 7:

Initialize Timing

Click Finish to complete the timing initialization.

The blue shaded areas that precede the rising edge of the CLOCK correspond to the
Input Setup Time in the Initialize Timing dialog box. Toggle the DIRECTION port to
define the input stimulus for the counter design as follows:

¢ Click on the blue cell at approximately the 300 ns to assert DIRECTION high so
that the counter will count up.

¢ Click on the blue cell at approximately the 900 ns to assert DIRECTION low so
that the counter will count down.

ISE Quick Start Tutorial
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Note: For more accurate alignment, you can use the Zoom In and Zoom Out toolbar buttons.

EE Xilinx - ISE - C:MutorialMutorial.ise - [counter_tbw] E|@|rg|
BB File Edit “iew Project Source Process Test Bench Simulation Window Help =1 ]
DPHG LR ERRD BARLAL AR AN (X BE| 0| M E] v]
i BE DD Ot &EH AAXHED . = E

End Time:

1500 ns 120 ns 280 ns 440 ns B00 ns TEO ns 920 ns 1080 ns 1240 ns 1400 ns

et b lbereloorolbeerlbooelbor

ANl cLock 0

A DIRECTION 0 | |
HplocoUNT_ U, 0 ¢ 0
=cnunter_tbw ‘

Figure 8: Test Bench Waveform

10. Save the waveform.

11. In the Sources window, select the Behavioral Simulation view to see that the test
bench waveform file is automatically added to your project.

Sources

<

Sources for | SynthesizdAmplementation

fﬂj tutar| Synthesis/dmplementation
=M ey Echavioral Simulation
Post-Foute Simulation

Ef Sources | #5 Snapshots [yl »

Figure 9: Behavior Simulation Selection

12. Close the test bench waveform.

Simulating Design Functionality

Verify that the counter design functions as you expect by performing behavior simulation
as follows:

1. Verify that Behavioral Simulation and counter_tbw are selected in the Sources
window.

2. Inthe Processes tab, click the “+” to expand the Xilinx ISE Simulator process and
double-click the Simulate Behavioral Model process.

The ISE Simulator opens and runs the simulation to the end of the test bench.

3. To view your simulation results, select the Simulation tab and zoom in on the
transitions.
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The simulation waveform results will look like the following:

EE Xilinx - ISE - C:\tutorial\tutorial.ise - [Simulation] =3
Em File Edit “iew Project Source Process Test Bench Simulation Window Help =1 ]
DPHI PR EFRAESEUARLYL AR LR (XRE oo W& v
T BE DD Y T AE AL2XE DB &2
Now:

1540 ns

& clock 1

& direction 1]

@i count_out[3:0] 10

ﬁ Simulation .

Figure 10: Simulation Results

Note: You can ignore any rows that start with TX.
Verify that the counter is counting up and down as expected.

5. Close the simulation view. If you are prompted with the following message, “You have
an active simulation open. Are you sure you want to close it?”, click Yes to continue.

You have now completed simulation of your design using the ISE Simulator.

Create Timing Constraints

Specify the timing between the FPGA and its surrounding logic as well as the frequency
the design must operate at internal to the FPGA. The timing is specified by entering
constraints that guide the placement and routing of the design. It is recommended that you
enter global constraints. The clock period constraint specifies the clock frequency at which
your design must operate inside the FPGA. The offset constraints specify when to expect
valid data at the FPGA inputs and when valid data will be available at the FPGA outputs.
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Entering Timing Constraints

To constrain the design do the following:

1.
2.
3.

4.

Select Synthesis/Implementation from the drop-down list in the Sources window.
Select the counter HDL source file.

Click the “+” sign next to the User Constraints processes group, and double-click the
Create Timing Constraints process.

ISE runs the Synthesis and Translate steps and automatically creates a User
Constraints File (UCF). You will be prompted with the following message:

= Project Navigator, &|
P This process requires that an Implementation Constraint File {UCF) be added
\.1) ko the project and associated with the selected design module, Wiould wou like
Project Mavigator ko automatically create a UCF and add it to the project at
this time?
IF ywou select "Mo" wou will need to create or add an exisking UCF ko the project
before running this process,

e J w ]

Figure 11: Prompt to Add UCF File to Project

Click Yes to add the UCF file to your project.

The counter.ucf file is added to your project and is visible in the Sources window.
The Xilinx Constraints Editor opens automatically.

Note: You can also create a UCF file for your project by selecting Project —Create New
Source.

In the next step, enter values in the fields associated with CLOCK in the Constraints
Editor Global tab.

Select CLOCK in the Clock Net Name field, then select the Period toolbar button or
double-click the empty Period field to display the Clock Period dialog box.

nr
et
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6. Enter 40 ns in the Time field.

# Clock Period

Initial active edge used for

OFFSET walue is set to HIGH |% PERIOD —){ ;
A
— |— MPUTITTER

TIMESFELC Mame:

|T5_CLOCK, |
Clock Met Mame:
|CLOCK, |
Clock Signal Detintion
%) Specify Time
Tirne: 140 | Units: | ns ~|
(%) Start HIGH () Start LOW
Time HIGH: (50 | Units: | % v
Figure 12: Clock Period
Click OK.

Select the Pad to Setup toolbar button or double-click the empty Pad to Setup field to
display the Pad to Setup dialog box.

9. Enter 10 ns in the OFFSET field to set the input offset constraint.

# Pad to Setup

D Diata
u
=P N
defined by

Tine Requirement

DOFFSET: 10 | Units: [re v
Relative to Clock Pad Met: | CLOCK. v|
Relative to Clock Edge: | v|
Cormment: | |

Figure 13: Pad to Setup
10. Click OK.
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11. Select the Clock to Pad toolbar button or double-click the empty Clock to Pad field to
display the Clock to Pad dialog box.

ir
12. Enter 10 ns in the OFFSET field to set the output delay constraint.

& Clock to Pad X]

Diata
]
— =l oFFseT Cancel
lF
I\Active edge Apply
defined by
PERIOD

=P

Time Requirement

OFFSET: 10 | Urits: [re v
Fielative to Clock Pad Met: | CLOCK v|
Relative to Clock Edge: | v|
Comment; | |

Figure 14: Clock to Pad

13. Click OK.

The constraints are displayed in the Constraints (read-write) tab, as shown below:

4 Xilinx Constraints Editor - [Global - counter.ngd|/ counter. ucf]
25 File Edit View ‘Window Help (=]
0P H X A0 AN

Clock Met Mame Period Pad to Setup Clock to Pad
CLOCK 40 ns HIGH 50 % 10 ns 1D ns

-@ Global .@ Ports .@ Advanced .@ Mizc

MET "CLOCK" TMM_MET = "CLOCK";

TIMESPEC "TS_CLOCK" = PERIOD "CLOCE" 40 niz HIGH 50 %;
=\ OFFSET = IM 10 ns BEFORE "CLOCK" :

OFFSET =0UT 10 ns AFTER "CLOCK!

Errors Wi amings Info Meszages

Congtraints [read-write) J Canstraintzs [read-anly] Source Constraints [read-only)

Figure 15: Timing Constraints

14. Save the timing constraints. If you are prompted to rerun the TRANSLATE or XST
step, click OK to continue.

15. Close the Constraints Editor.
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Implement Design and Verify Constraints

Implement the design and verify that it meets the timing constraints specified in the
previous section.

Implementing the Design

1. Select the counter source file in the Sources window.

2. Open the Design Summary by double-clicking the View Design Summary process in
the Processes tab.

3. Double-click the Implement Design process in the Processes tab.

Notice that after Implementation is complete, the Implementation processes have a
green check mark next to them indicating that they completed successfully without
Errors or Warnings.

&= Xilinx - ISE - C:Mutarial\utorial. ise - [Design Summary]
L File Edt View Project Source Process ‘Window Help [ (X5
i PPHEA R ARSI AN:NG_ ~:DPHA LixBBX 9a[@B:¢
EE A BEALN 0O

e e R IS | I FPGA Design Summary h TUTORIAL Project Status B
5 for: | Synthesis/Implementation + | Mumber of: | LUT Sl : ;
! U_WCES Sl ECTEREER SN el et ‘@Deslgn Overview Project tutorialise Current State: Placed and Routed
| Hierarchy Resauices | Preserve Summary File:
| : 5] tunoral 0B Properties Module [ caunter + Errors:
= 23 we3s200-401256 Timing Constraints Name:
& figleF counter - Behavioral [counter. vhd) - [4) Pinout Report Target | wc3s200-41256 + Warnings:
Clock Report Device:
(3Enors and Warmings [Product [ ISE 82 | euUpdated: | Tuedpr 5
Syrthesis Messages Yersion: 15:37:4F 2008
; Translation Messages )
Map Messages TUTORIAL Partition Summary
Place and Route Messages No partition information was found.
Timing Messages
# i:‘tg;n Mesr:ages Device Utilization Summary
. unent Messages T
| 2 : Logic Utilization Used | Available | Utilization = Note(s]
‘@Delalled Reports i 3 S i .
1 Synthesis Report . Numl.Jer of S.|IC.E Flip Flops 4 . 3,840 1% .
; Tranglation Report Number of 4 input LUT s 4 | 3,840 1% .
I P Map Repart Logic Distribution
T ] Flace and Route Report — || | Number ol.occup\ed. [ 3 1,920 | 1%
| Static: Timing Feport Sli
[ AddExisting Souce E'ta N Flimlngt ERe 1 o= 1 I
Itgen nepar i b
M Create New Source g P v Nul_'nt_:er of Slices 3 3 100%
X X .| | containing only related
L View Design Summary Project Properties logic
7] ? Design Utilities ]:[ Enable Enhanced Design S = 3
= ﬁ User Conshraints E Enable Message Filtering co?tl:i-;kij:gl Eigig;ﬁjd ogic L 3 0
e . Display Incremental Messsages . . o :
Create Timing Constraints %
@ Enhanced Design Summary Contents :I'otal Number of 4 4 3840 1%
fissign Package P!
gn Package Pin: input LUT e
; Show Partition D ata |
Create Area Constraints O Shov Errors Number of bonded [0Bs 3 173 s
(5]  Edt Constairis Tex] Show Warmings | Number of GCLEs 1 8 12%
# £ synthesize - X5T O Show Failing Constraints T PR RS =
B ()|mplemenl Design DI Show Clack Report count for design
& C}Tlanslate e . -
i @M | Additional JTAG gate 288
i S: P count for 1083
& Place & Foute
2} G te: P Fil
] SR IOIIINTHE Performance Summary v

| @—c Processes

T Design Summary

Figure 16: Post Implementation Design Summary

5. Locate the Performance Summary table near the bottom of the Design Summary.
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6. Click the All Constraints Met link in the Timing Constraints field to view the Timing
Constraints report. Verify that the design meets the specified timing requirements.

E Design Summary |Z||E|P5__<|
File View Window Help

ceoRm

= : A ;
. FPGA Design Summary *| | Met | Constraint Renuested | Actusl Logic  Absolute | Mumber of
%3 Design Overview Level:  Slack emors

Summary OFFSET =0UT 10 ns AFTER COMP "CLOCK" 10000ns| 9.0%nd 1| Da0dnd
I0B Properties —||es |OFFSET =IN 10 ns BEFORE COMP "CLOCK” 10.000ms 1.141ns 3 @85ns o
Timing Constraints Yes | T5_CLOCK = PERIOD TIMEGRP "CLOCK! 40 ns HIGH 50% 40000ns. 3 477ns 0 36523ns o
Finout R eport
Clock Report

@Enors and ‘W arnings
[ Cunthesic Massane: e

Timing Congtraints ~
(=~ Show Columns 7
et
Coristraint
Fequested B
Actual
Logic Levels
L Y [T 0

Figure 17: All Constraints Met Report

7. Close the Design Summary.

Assigning Pin Location Constraints

Specify the pin locations for the ports of the design so that they are connected correctly on
the Spartan-3 Startup Kit demo board.

To constrain the design ports to package pins, do the following;:

1. Verify that counter is selected in the Sources window.

2. Double-click the Assign Package Pins process found in the User Constraints process
group. The Xilinx Pinout and Area Constraints Editor (PACE) opens.

3. Select the Package View tab.

In the Design Object List window, enter a pin location for each pin in the Loc column
using the following information:

¢ CLOCK input port connects to FPGA pin T9 (GCKO signal on board)

¢+ COUNT_OUT<0> output port connects to FPGA pin K12 (LDO signal on board)
¢ COUNT_OUT<1> output port connects to FPGA pin P14 (LD1 signal on board)
¢ COUNT_OUT<2> output port connects to FPGA pin L12 (LD2 signal on board)
¢+ COUNT_OUT<3> output port connects to FPGA pin N14 (LD3 signal on board)
¢ DIRECTION input port connects to FPGA pin K13 (SW7 signal on board)
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Notice that the assigned pin locations are shown in blue:

#% Xilinx PACE - C:Mutorial\counter. uct
File Edit View IOBs Areas Tools ‘Window Help

DEE & v | #u LK [H
B =13

+-3 140 Pins
3 Global Logic

N

||

12

COX

BE B4 & 8F @ i

[» |

345 678 9101112131418 16

ml e ] Cm] &
o 1MW Bmo|E
[ CIC] C
|| CJ || C
|| [ ] || E
| EEEEEE N
170 Name |1/0 Direction] Loc |Ba EEEEEE c
CLOCK Input 3
= COUNT_OUT<0 EIEtput K1z = == : : : : == - H
B COUNT_OUT<1> Output pld J
B COUNT_OUT<2> Output Iz HEEENENSs K
I COUNT_OUT<3> Output 4 B EEEEENe [
B CRECTION  [Input K || | ] | || by
|| L e I
- | ] CJ o F
| M nn F
Group |IJ'D Dilectiunl | [N O 9 [ nm
I 4 | COUNT_OUT | Dutput 12345678 910111213141516
< | Package View /i_Architecture '/ 4 | | »f.

Figure 18: Package Pin Locations

5. Select File —Save. You are prompted to select the bus delimiter type based on the
synthesis tool you are using. Select XST Default <> and click OK.

6. Close PACE.

Notice that the Implement Design processes have an orange question mark next to them,
indicating they are out-of-date with one or more of the design files. This is because the UCF

file has been modified.

Reimplement Design and Verify Pin Locations

Reimplement the design and verify that the ports of the counter design are routed to the
package pins specified in the previous section.

First, review the Pinout Report from the previous implementation by doing the following:

1. Open the Design Summary by double-clicking the View Design Summary process in

the Processes window.

ISE Quick Start Tutorial
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2. Select the Pinout Report and select the Signal Name column header to sort the signal
names. Notice the Pin Numbers assigned to the design ports in the absence of location
constraints.

File View Window Help
QOB M
& FPGA Design Summary | | Fin Signal Fin Fin Direction 10 10 Bank | Drive  Slew T
@Design Dvervisw Mumber = Mame Usage  Mame Standard Mumber | [m&]  FRate
Summary BS CLOCK 0B 10_L32N_0/GCLKT INFUT  LWCMOS25 i
[A 0B Propetties R7 COUNT_OUT<O0> 10B  I0_L31P_5/D5 OUTPUT | LYCMOS25 5 12 5L0w NOME
ming Canstraints M7 COUNT_OUT<T> 10B  10_L30F 5 OUTPUT | LYCMOS25 5 12 5L0w NOME
|Finout Report N7 COUNT_OUT<2> 10B  10_L30M_5 OUTPUT | LYCMOS25 5 12 5L0w NOME
Llock Report P7 COUNT_OUT<3> 0B 10 OUTPUT | LYCMOS25 5 125L0W NONE
@Ellf'; "‘”:W"‘L:'”gs ol |8 DIRECTION 0B I0_L23F_5AREF_S INFUT | LWCMOS25 5
i
: piiEs Hessane &7 0B 10 UNUSED 0
| Pinout Report ~
) Show Calumns A8 DIFFM  |10_L32F_0/GCLKE UNUSED o
Pin Munber 43 OB 10 UNUSED 1
Signal Name A10 DIFFS  10_L3TN_1A/REF_1 UNUSED 1
Pin Usage = | i . Ve b
3 > < >

Figure 19: Package Pin Locations Prior to Pin Location Constraints

3. Reimplement the design by double-clicking the Implement Design process.

Select the Pinout Report again and select the Signal Name column header to sort the
signal names.

5. Verify that signals are now being routed to the correct package pins.

% Design Summary:

File View Window Help
QOB M
& FPGA Design Summary | Pin Signal Pin Pin Direction 10 10 Bank  Drive  Slew TerrrA
@Design Dverview Mumber = Mame Usage  Mame Standard Mumber | [m&]  FRate
Surmmany 79 CLOCK, 0B I0_L32P_4/GCLKD INPUT | LYCMOS25 4
[2)10B Propeties K12 COUNT_OUT<D> 0B |10_L23N_3 OUTPUT | LYCMOS25 3 12/5L0w NON
[2) Timing Constraints P14 COUNT_OUT<T> I0B I0_L16P_3 OUTPUT | LYCMOS25 3 12/5L0w NON
L1z COUNT_DUT<2> I0B  I0_L23F_3/VREF_3 OUTPUT | LYCMOS25 3 12/5L0w NON
C'UCKF‘BDU'_t N14 COUNT_OUT<3> I0B I0_L19P_3 OUTPUT | LYCMOS25 3 12/5L0w NON
@Ellf'; "‘”:W"‘L:'”gs o K13 DIRECTION 0B I0_L24P_3 INFUT  LVCMOSZ5 3
L sunlhesi Hessans a7 0B |10 UNUSED 0
| Pinout Report ~
5. Show Colurns A3 DIFFM | I0_L32P_0/GCLKE UNUSED 0
Pin Nurber 43 0B 10 UNUSED 1
Signal Name 10 DIFFS I0_LIIN_1A/REF_1 UNUSED 1
Pin Usage ¥ aan AL b
< ¥ ||¢ »

Figure 20: Package Pin Locations After Pin Location Constraints

6. Close the Design Summary.

Download Design to the Spartan™-3 Demo Board

This is the last step in the design verification process. This section provides simple
instructions for downloading the counter design to the Spartan-3 Starter Kit demo board.

1. Connect the 5V DC power cable to the power input on the demo board (J4).
2. Connect the download cable between the PC and demo board (J7).
3. Select Synthesis/Implementation from the drop-down list in the Sources window.
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Select counter in the Sources window.

In the Processes window, click the “+” sign to expand the Generate Programming
File processes.

Double-click the Configure Device (iMPACT) process.
The Xilinx WebTalk Dialog box may open during this process. Click Decline.

Select Disable the collection of device usage statistics for this project only and
click OK.

iMPACT opens and the Configure Devices dialog box is displayed.

=5 MPACT - Welcome to iMPACT [ZJ|E|E|

Flease select an action from the: lizk below

(#) Configure devices using Boundary-Scan [JTAG)
Autornatically connect to a cable and identify Boundary-Scan chain
(") Prepare a PROM File
(") Prepare a Syster ACE File
(") Prepare a Boundarp-5can File
SWF
() Configure devices

uzing Slave Serial mode

< Back | Finish | [ Cancel l

Figure 21: iMPACT Welcome Dialog Box

9. In the Welcome dialog box, select Configure devices using Boundary-Scan (JTAG).

10. Verify that Automatically connect to a cable and identify Boundary-Scan chain is
selected.

11. Click Finish.
12. If you get a message saying that there are two devices found, click OK to continue.

The devices connected to the JTAG chain on the board will be detected and displayed
in the iMPACT window.
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13. The Assign New Configuration File dialog box appears. To assign a configuration file
to the xc3s200 device in the JTAG chain, select the counter .bit file and click Open.

Sources

L File Edit Wiew Project Source Process Operations Output Debug Window Help
DPHS L deBX Do QIPPHHE BN BEDD:LRME ¥V
A BUARN:QO vk

x

e B0 IR

‘SalBoundary Scan
‘BalSlaveSenial
TalSelectMAP

‘eIl esktop Configuration
2% Direct SPI Configuration
[E)SustemaE

[E]PROM File Foimatter

= Assign New Configuration, File

#3200 xcfl2s
--- file 7 --- --- file 7 ---

Look in: [ {3 C:/Projects/iade/05T Autorial v| @& & ek
. Cisim ) templates

E_ngo Biswm tmp_save Exsl
) _smsgs [Chnetgen counter bit

File name: |

File type: | Al Design Files [".bit * bt “.nky " isc *bad) vl

Er$ Sources 5 Snapshats |E Libraries Carfiguration Modes
Processes x
E“-‘:Plocesses | Configuration Operations
Transcript x
/4 *%+ BATCH CHMD : setMode -hs ~
/4 *%+ BATCH CHMD : setMode -hs =
GUI --- Auto connect to cable...
/4 #%% BATCH CMD : setCable -port asuto v
3 | ¥

Corsole |° Emors |t Wamings | & Tel Shell | [ag Find in Files

|

Cancel Al ] ’ Bypass ]

(&) Mone

() Enable Programming of SPI Flash Device Attached to this FPGA
() Enable Programming of BPI Flash Device Attached to this FPGA

i Desian Summary

,ffe Boundary Scan

Configuration | Parallel I | 200 KHz | LPT1

Figure 22: Assign New Configuration File

14. If you get a Warning message, click OK.

15. Select Bypass to skip any remaining devices.

16. Right-click on the xc3s200 device image, and select Program... The Programming
Properties dialog box opens.

17. Click OK to program the device.

When programming is complete, the Program Succeeded message is displayed.

Program Succeeded

On the board, LEDs 0, 1, 2, and 3 are lit, indicating that the counter is running.
18. Close iMPACT without saving.

You have completed the ISE Quick Start Tutorial. For an in-depth explanation of the ISE
design tools, see the ISE In-Depth Tutorial on the Xilinx® web site at:
http:/ /www.xilinx.com/support/techsup/tutorials/
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